
New in version 2.0
The Web Site Manager
One of the biggest and best changes in WebExpress 2.0 is the focus on the web site as 
opposed to individual web pages. WebExpress now conveniently tracks all the links in your
web site starting from your home page down. The Web Site Manger visually displays the 
pages in your site, including links to pictures, email references and downloadable files.
Web Sites (as they are termed in WebExpress) simulate the real web site on your internet 
server. They are easy to create, and we strongly urge you create one and use it. Simply 
use New Web Site from the File Menu, and enter the base URL for your web site and the 
path to your home page on your computer (you can browse for it). WebExpress will take 
care of the rest.

Major Features of the Web Site Manager
n Web Site Organization and Navigation

Visually tracks the pages in your web site, and how they are linked. Double click on a 
page in the Web Site manger to load and edit the page. Easily identifies the different 
links including links within your web site, links to other sites on the World Wide Web, 
images, bookmarks, email and image maps. Expand and Collapse pages to control the 
viewing of your entire web or portions of it. And best of all, the Web Site Manager does 
this all automatically, so that as links are added or removed, the Web Site is always kept
up to date.

n Convenient Project Management
The Web Site remembers from session to session which the last web site being worked 
on, which files were left open and which ones were closed. Each time WebExpress is 
launched, it recalls the last web site, sets up all the web site directories, and opens the 
files last being edited. A great time saver.

n Visual Validation of Web Site Connectivity
Quickly identifies broken links in your web site with visual indicators such as a broken 
link icons and distinctive text colors. If a page does not exist, double clicking on the 
broken link automatically creates a new page with the correct name and URL. Allows you
to quickly scan your site to validate all local links before uploading to the Web.

n Manage Filename Case Sensitivity in Site URLs
Windows based systems and UNIX based web servers handle case sensitivity in 
filenames differently. UNIX treats files with the same spelling but differing in case as 
different files, whereas Windows treats them as the same. This can cause Windows 
based users problems when developing a web site, and lead to broken links once the 
web site is activated on the Web.
You can choose to allow WebExpress' Web Site Manager to monitor the case your URLs, 
and force them to always be written in a consistent way, either upper or lower case. 
Optionally, it will force filenames to also always use the same case as the URL (32 bit 
Windows only). 

n Web Site Image Maps
Image Maps can be stored by the Web Site Manager, making them immediately 
available to new pages created within your site. This makes adding a graphical site map 



to your web pages a snap. And when the image map is changed, each web page which 
uses it can automatically be updated with the new information.

Next



Browser Launcher
WebExpress is one of the most WYSIWYG editors on the market. Every attempt is made to 
follow the HTML 3 specifications as closely as possible, and to mimic the behavior of the 
major web browsers, especially Netscape Navigator and Microsoft Internet Explorer. 
Unfortunately, due to the nature of HTML and the battle for browser supremacy, it is 
impossible to completely match the behavior for all browsers, since their displays differ in 
many ways.
To allow you to view exactly how your page will look in a browser, WebExpress now allows 
you to launch the current page into a browser from within WebExpress. You can configure 
up to two different browsers which can be launched. WebExpress currently searches for 
and automatically configures Netscape Navigator, Mosaic and Microsoft Internet Explorer. 
If you configure another browser manually, please email us the details so that we can 
include it in future automatic configurations.
Next Previous



Frame Support
WebExpress now supports the creation and management of frame based web sites. The 
frame based page is typically the web site's home page, and defines how the display is 
laid out when the web site will be viewed in a browser. Any page, however, can be 
designated as a frame page, and can also contain a supplemental page for viewers whose 
browser do not support. 
To switch between the Frame portion of the page and the supplemental page check the 
appropriate option on the View menu. 
If you are switching to a frame based web site, you can conveniently use your current 
home page as a starting point. First load your current home page into WebExpress. Next, 
switch to Frame Page view using the View menu. Arrange the frames like you want them. 
Finally, save the page. Your home page will now be setup to support frames, with your old 
home page being displayed as the alternative for browsers not supporting frames.
Next Previous



Form Support
Full support for creating forms is now available within WebExpress. You can add a form 
anywhere within a web page. The tools to create forms are found on the Insert menu. You 
can also turn on a floating toolbar called Form Tools which provides for convenient access 
while creating the form. Form Tools can be turned on from the View menu or from the 
Control Strip bar.
Form commands include:
n Insert Form - Creates a new form section into which form elements can be placed. 
n Clear Form - Ends the form at the current paragraph. This is useful 
n Text Box - Inserts a text box into which visitors to your web page can enter information. 
n Check Box - Inserts a check box control which indicates whether an item is selected or 

not.
n Radio Button - Inserts a radio button control which indicates a specific item in the form is

selected.
n Drop Down Menu - Inserts a menu control which allows a list of items to be displayed.
n Push Button - Inserts a push button used to designate some sort of action for the form.
Next Previous



Font Sets - The Facename Extension
WebExpress now supports the Face extension found in Netscape 3.0 and MS Internet 
Explorer 3.0. This allows you to specify the typeface a browser should use when displaying
text. The browser decides which typeface to use by checking a list of typefaces 
sequentially to find one available on the visitor's computer.
In WebExpress, the face extension is handled by font sets. A Font Set is a named list of 
typefaces which the browser will search when the web page is loaded. The typefaces in 
the list may include typefaces not available on your system, in fact, you may want to 
include typefaces which are only available on Macintosh or UNIX systems so that viewers 
on those systems also benefit from the selection.
You can define as many Font Sets as you wish, but keep in mind that the more unique the 
typeface, the less chance it will exist on a visitor's computer. To use a Font Set to text, you
apply it just as you would a normal typeface in a word processor or desktop publisher. You 
can access the Font Set definition dialog from the Utility menu or from the 
Format/Character dialog box.
Next Previous



JavaScript Support
You can now include and edit JavaScript, VBScript and other scripting languages from 
within WebExpress. To edit your scripts, use the Script command from the Edit menu. This 
will show a list of all scripts currently contained in the document. You can then add new 
scripts, edit existing scripts, and delete scripts from your web page.
Next Previous



Show Paragraph Breaks
Showing paragraph breaks is an old feature with new meaning. Turning this feature on via 
the View menu now differentiates between the HTML commands New Paragraph <P> and 
Break <BR>. When turned on, the following symbols are displayed depending on the type 
of line break.

¶ This symbol denotes line breaks which correspond to the Paragraph <P> HTML 
command, and generally have a larger amount of space between lines. This type of 
break is created by pressing the Enter key.
¬ This symbol denotes line breaks which correspond to the Break <BR> command. 
These types of line breaks generally have a smaller amount of space between lines. 
This type of break is created by pressing the Enter key while holding down the shift 
key.

There are a number of situations where the two types breaks generate the same amount 
of space, which is generally the same as the Paragraph <P> command. This usually 
occurs when something other formatting command is different between the two blocks of 
text, for example a change in alignment from Center to Left.
You can also change the type of line break by toggling the New Paragraph command on 
the Format menu.
Previous



New Web Site
Use the "File | New Web Site" command to create a new web site.    Choosing this 
command displays the “New Web Site” dialog box, described below, from which you can 
specify the location of the new web site both on the World Wide Web and on your local 
machine.

New Web Site Dialog
Base URL: Specify the location of your web site on the World Wide Web.
Base Directory: Specify the directory which contains your web site on your local 
machine.
Home Page: Specify the name of the HTML document which contains your home page.    
You may click on the button to the left of this field to bring up a file browse dialog box 
which lets you browse for your home page.    Choosing a file in this manner will 
automatically set both the “Base Directory” and    “Home Page” fields.
See also: Web Site Properties



Form Properties
Use the "Edit | Form Properties" command in the web page editor to edit the properties of 
a form. The text cursor must be within a form for this command to be active. Choosing this
command displays the “Form Properties” dialog box described below.

Form Properties Dialog
Action: Specifies the address to be used to carry out the action of the form.    Typically 
this is the URL of a CGI script.
Method: Indicates how the form data should be sent to the server.    Typically, this field 
will either contain “GET” which means that the arguments should be appended to the 
action URL and opened as if it were a anchor.    “POST” means that the data should be sent 
via an HTTP post transaction.
Encoding: Specifies the MIME content type to be used to encode the form contents.
Hidden Fields: The list box list all hidden fields for the form.    You can add new fields by 
entering the name and value in the “Name” and “Value” edit fields and then clicking the 
“New” button.    Fields can be also be changed or deleted using the “Change” and    “Delete” 
buttons.
Advanced: This displays the “  HTML Extensions  ”   Dialog   box which allows you to enter any 
arbitrary HTML attribute to the form.



Scripts
Use the "Edit | Scripts" command in the web page editor to add, edit, or delete a script.    
Typically this will either be a Java script or a Explorer VB script. Choosing this command 
displays the “Edit Scripts” dialog box described below.

Edit Scripts Dialog
The list box to the left displays a list of all of the scripts in the document.    You can click on
a script to edit or delete it.
Type: Specifies the type of script.    Typically this will be either “JavaScript” or “VBScript”.
Add: Click this button to add a new script to your document.
Change: Click this button to change the currently selected script.
Delete: Click this button to delete the currently selected script.



Frame Based Web Pages
You can create a frame based home page by adding frames to any existing page.    To 
create frames, you would switch to “Frame View” via the “View | Frames” menu command 
described below.    You can then create the frame layout for your home page as well as 
specify the initial pages which are to be loaded into the frames.

View Web Page
Use the “View | Web Page” command in the web page editor to view the alternate page 
which is displayed in non-frame browsers.    If the page you are creating does not contain 
frames then this will be the only view you will use.

View Frames
Use “View | Frames” to view the frames defined for the web page.    You would use this 
command to create a frame based home page.    Once frames are added to a page, the 
document that existed previously becomes the alternate page which is displayed in non-
frame browsers.



View In Browser
Use the “View | In Browser” command in the web page editor to view the page in a web 
browser.    If you have browsers configured, this command will specify the name of the 
browser (e.g. “View | In Netscape Navigator”).    You can configure up to two different 
browsers.    WebExpress currently searches for and automatically configures Netscape 
Navigator, Mosaic and Microsoft Internet Explorer.    If you configure another browser 
manually (see “  Edit | Preferences  ”  ), please email us the details so that we can include it in 
future automatic configurations.



Show Form Tools
Use the “View | Show/Hide Form Tools” command in the web page editor to display or hide 
the form tools floating tool bar.    This tool bar allows you to create forms, as well as insert 
form elements such as a text box or push button.



Create Form
Use the “Insert | Create Form” command in the web page editor to create a new form.    
Simply select the text which you wish to encompass the form and choose this command.    
The bounds of the new form will be indicated by a dotted line.



Clear Form
Use the “Insert | Clear Form” command in the web page editor to remove an existing form.



Form Field
Use the “Insert | Form Field” command in the web page editor to display a list of the form 
elements which you can insert into your document.    To insert an element, simply click on 
the desired element in the sub-menu.    You can also turn on a floating tool bar which 
allows you to enter form elements (see “  View | Show Form Tools  ”  .    The available form 
elements are described below:
Once a form element has been created, you can edit the properties of the element by 
double clicking on it.

Text Box
Inserts a text box into which visitors to your web page can enter information.    Choosing 
this command brings up the “  Text Box Properties  ”   dialog box which allows you to set the 
properties for this text box.

Check Box
Inserts a check box control which indicates whether an item is selected or not.    Choosing 
this command brings up the “  Check Box / Radio Button Properties  ”   dialog box which allows 
you to set the properties for this check box.

Radio Button
Inserts a radio button control which indicates a specific item in the form is selected.    
Choosing this command brings up the “  Check Box / Radio Button Properties  ”   dialog box 
which allows you to set the properties for this radio button.

Drop Down Menu
Inserts a menu control which allows a list of items to be displayed.    Choosing this 
command brings up the “  Drop Down Menu Properties  ”   dialog box which allows you to set 
the properties for this menu.

Push Button
Inserts a push button used to either submit or clear the form.    Choosing this command 
brings up the “  Push Button Properties  ”   dialog box which allows you to set the properties for
this push button.



Font Sets
Use the “Utilities | Font Sets” command in the web page editor to create and manage font 
sets.    WebExpress supports the Face extension found in Netscape 3.0 and MS Internet 
Explorer 3.0. This allows you to specify the typeface a browser should use when displaying
text. The browser decides which typeface to use by checking a list of typefaces 
sequentially to find one available on the visitor's computer.
In WebExpress, the face extension is handled by font sets. A Font Set is a named list of 
typefaces which the browser will search when the web page is loaded. The typefaces in 
the list may include typefaces not available on your system, in fact, you may want to 
include typefaces which are only available on Macintosh or UNIX systems so that viewers 
on those systems also benefit from the selection.
You can define as many Font Sets as you wish, but keep in mind that the more unique the 
typeface, the less chance it will exist on a visitor's computer. To use a Font Set to text, you
apply it just as you would a normal typeface in a word processor or desktop publisher. You 
can access the Font Set definition dialog from the Utility menu or from the 
Format/Character dialog box.

Font Sets Dialog
This dialog box allows you to create and edit font sets.
Font Sets: Displays a list of the currently defined font sets.    To edit or delete a font set 
you should select the appropriate font set from the list.
New: Click this button to add a new font set to the list.    This will bring up the “  Edit Font   
Set  ”   dialog box, which will allow you to specify the fonts to be included.
Modify: Click this button to edit the currently selected font set.    This will bring up the 
“  Edit Font Set  ”   dialog box which will allow you to modify the fonts that are included.
Delete: Click this button to delete the currently selected font set.
Fonts Included: This field displays the list of fonts included in the currently selected font 
set.



Frame Properties
Use the “Edit | Frame Properties” command in the web page frame editor to edit the 
properties of the currently selected frame.    The “Frames Properties” dialog box is 
described below.
To view the frames defined for a page, use the “  View | Frames  ”   command.

Frame Properties Dialog
Name: Specify the name of the frame.    This is name is used to identify the frame so that 
pages can be directed to it.
Source URL: Specifies the URL of the initial page which is to be displayed in this frame.    
You can click on the button to the right to bring up the “  Create/Edit Link  ”   dialog box which 
allows you to select any URL available in your web site.
Margin Height: Specifies the height of the margin above and below the frame.
Margin Width: Specifies the width of the margin to the left and right of the frame.
Frame Border: If this box is checked, then the frame will be displayed with a border.
Scrolling: If this box is checked, then the frame will have scroll bars.
No Resizing: If this box is checked then the user will not be allowed to resize the frame.



Frame Set Properties
Use the “Edit | Frame Set Properties” command in the web page frame editor to edit the 
properties of the currently selected frame set.    The “Frame Set Properties” dialog box is 
described below.
To view the frames defined for a page, use the “  View | Frames  ”   command.

Frame Set Properties Dialog
Rows: Specifies the number of rows in the frame set.
Columns: Specifies the number of columns in the frame set.
Spacing: Specifies the amount of space between frames of the frame set
Frame Border: Check this box if you want borders around the frames.
Scrolling: Check this box if you wish scroll bars to be displayed in the frames.



Split Frame
Use the “Frame | Split Frame” command in the web page frame editor to split the selected 
frame into a sub-frame set.    The “  Frame Set Properties  ”   dialog box is displayed in which 
you can specify the properties of the sub-frame set.



Combine Frames
Use the “Frame | Combine Frames” command in the web page frame editor to combine the
frames of the selected frame set into a single frame.    This is the inverse of the “  Frame |   
Split Frame  ”   command.    The data contained in the first frame of the frame set will be 
placed in the combined frame.    All other frame data will be lost.



Insert Row
Use the “Frame | Insert Row” command in the web page frame editor to insert a new row 
before the currently selected frame.    To add a row after the last row, use the “  Edit | Frame  
Set Properties  ”   command and increase the number of rows.



Insert Column
Use the “Frame | Insert Column” command in the web page frame editor to insert a new 
column before the currently selected frame.    To add a column after the last column, use 
the “  Edit | Frame Set Properties  ”   command and increase the number of columns.



Delete Row
Use the “Frame | Delete Row” command in the web page frame editor to delete the row 
containing the currently selected frame.



Delete Column
Use the “Frame | Delete Column” command in the web page frame editor to delete the 
column containing the currently selected frame.



Open Page / Create Page / Edit Image Map
In the Web Site Manager, if you have an existing page selected, you can use the “File | 
Open Page” command to load the selected page into a Web Page Editor window for 
editing.    
If you have a page selected which does not exist (broken link) this command will change 
to “Create Page”, allowing you to create the page.    
If you have a web site image map selected, This command will change to “Edit Image 
Map”, allowing you to edit the image map.    You can only edit web site image maps in this 
manner



Add Page
Use the “Edit | Add Page” command in the web site manager to add a new root page to 
your web site.



Remove Page
Use the “Edit | Remove Page” command in the web site manager to remove a root page 
from your web site.    Note that only root pages may be removed.    All other pages appear 
because of links in your web pages.



Update Web Pages
If you change the text case of your link URLs (see ”  Edit | Web Site Properties  ”  ) or if you edit
a web site image map (see “  File | Edit Image Map  ”  ), all pages in your web site must be 
loaded and saved in order for them to reflect these changes.    This command in the web 
site manager provides a convenient way to accomplish this.



Web Site Properties
Use the “Edit | Web Site Properties” command in the web site manager to modify the 
location and properties of your web site.    The following dialog box is displayed.

Web Site Properties Dialog
Base URL: Specifies the base URL for your web site on the World Wide Web.
Base Directory: Specifies the base directory for your web site on your local machine.
Image Sub-directory: Specifies the location of your images directory.    This can be the 
same directory as your base directory (in which case this field will be blank), or it can be 
any sub-directory within your base directory.    You cannot specify an image directory 
outside your base directory structure.    If you add an image which is not within you web 
site directories, you will be asked if you wish to copy the image file to this image directory.
Update links when: If you want your web site links updated whenever you open your 
web site, check “Web site is opened”.    If you would like them updated whenever you save 
a document in the web page editor, check “Web page is saved”.    Links are updated by 
reading all web pages which have changed since the last update.



Expand / Collapse Link
In the web site manager window, you will see a list of your web pages, starting with your 
home page(s).    If a page has a little plus symbol ‘ ’ next to it this means that this page 
contains links to other pages.    To display those links, use the “File | Expand Link” 
command or single click on the plus symbol.    If the link is already open, a little minus 
symbol ‘
’ will appear next to it.    In this case, the command will be “File | Collapse Link”.    Choosing 

this command will hide the pages to which the selected page is linked.



Expand All Links
In the web site manager, when you expand the links of a page (see. “  File | Expand Link  ”  ) 
you will see all of the pages to which the selected page is linked listed below it.    If any of 
these pages have links to other pages, these links will not automatically be expanded.    
Use the “File | Expand All Links” command to expand the links of the selected page and all 
pages to which it is linked.



Collapse All Links
In the web site manager, if you collapse the links of a page (see “  File Collapse Link  ”  ), the 
pages to which the selected page is linked are no longer shown.    However, if while you 
had the links expanded, you expanded the links of pages beneath the current page, those 
links are not automatically collapsed.    When you collapse the parent page, you will not be
able to see them, but if you expand the link again, they will still be shown.    Use the “File | 
Collapse All Links” to collapse the selected page and all pages to which it is linked.



View Bookmarks
Use the “View | Bookmarks” command in the web site manager to display or hide 
bookmark links.    This displays the names of all bookmarks for a given page which are 
linked to from other pages.    This is not a list of bookmarks defined for that page.    A 
check will appear next to this command if bookmark links are visible.



View Global Links
Use the “View | Global Links” command in the web site manager to display or hide global 
links.    Global links are links to web pages which do not lie within your web site.    A check 
will appear next to this command if global links are visible.



View Images
Use the “View | Images” command in the web site manager to display or hide the names of
images referenced by web pages.    A check will appear next to this command if images 
are visible.



View Page Titles
Use the “View | Page Titles” to display or hide the titles for each web page.    The titles will 
be displayed next to the file name.    A check will appear next to this command if page 
titles are visible.



Check Box / Radio Button Properties Dialog
In the web page editor, this dialog box is displayed when you create a new check box or 
radio button control using the “  File | Form | Check Box / Radio Button  ”   menu commands or 
when you edit an existing control by either double clicking on it or single clicking and 
choosing the “  Edit | Properties  ”      menu command.
Name: Specifies the name for the control.    The name is required and may not contain 
blanks.
Value: Specifies the value for the control.
Type: Specifies the type of control, either “Check Box” or “Radio Button”

Checked: Specifies that this control is to be initially checked.
Advanced: Click this button to bring up the HTML Extensions dialog box which allows you 
to associate any arbitrary HTML attribute with this control.



Text Box Dialog Properties
In the web page editor, this dialog box is displayed when you create a new text box 
control using the “  File | Form | Text Box  ”   menu command or when you edit an existing 
control by either double clicking on it or single clicking and choosing the “  Edit | Properties  ”   
menu command.
Name: Specifies the name for the control.    The name is required and may not contain 
blanks.
Value: Specifies the initial contents for the control.
Width in characters: Specifies the width of the control.
Maximum characters: Specifies the maximum number of characters the user will be 
allowed to enter.    This value may only be set for single line controls.
Number of lines: Specifies the number of lines for the control.
Password field: Specifies that this field is a password field.    Text typed into a password 
field will be displayed as ‘*’.    This attribute may only be set for single line controls.
Scrolling Text Box: Specifies that scroll bars are to be added to the control.
Advanced: Click this button to bring up the HTML Extensions dialog box which allows you 
to associate any arbitrary HTML attribute with this control.



Edit Font Set Dialog
This dialog box allows you to specify which fonts are included in a font set.
Font Set Name: Specifies the name of the font set.
Available Typefaces: This combo box allows you to enter a new type face to add.    You 
can select a typeface from those available on your machine, or you can enter any name.    
Note that it is not uncommon to enter typefaces which are not available on your machine. 
For example you may wish to add typefaces which are common on Macintosh computers.
Font Set Selections: This list specifies which fonts are currently included in this font set.
Add: Click this button to add the typeface specified in the “Available Typefaces” combo 
box to the list of typefaces for this font set.
Delete: To delete a typeface, click on the typeface to be deleted in the “Font Set 
Selections” list box, and then click this button.
Up: Click this button to move the currently selected typeface up in the list.    Most 
browsers will search for typefaces in the order they appear in the list.
DN: Click this button to move the currently selected typeface down in the list.    Most 
browsers will search for typefaces in the order they appear in the list.



Drop Down Menu Properties Dialog
In the web page editor, this dialog box is displayed when you create a new drop down 
menu control using the “  File | Form | Drop Down Menu  ”   menu command or when you edit 
an existing control by either double clicking on it or single clicking and choosing the “  Edit |  
Properties  ”   menu command.
Name: Specifies the name for this control.    The name is required and may not contain 
blanks.
Choice: This field is used to specify a new choice name or edit an existing one.    The 
choices currently defined are displayed in the list box to the left.
Value: This field is used to specify the value for a choice.
Selected: Check this box if you want a specific choice to be initially selected.
Delete: To delete an existing choice, click on the choice in the list box to the left and click 
this button.
New: To create a new choice, enter the choice name and value and click this button.
Change: To edit an existing choice, click on the choice in the list box to the left, edit the 
choice name and value fields and then click this button.
Up: To move a choice up in the list, click on the choice in the list box and click this button.
Dn: To move a choice down in the list, click on the choice in the list box and click this 
button.
Advanced: Click this button to bring up the HTML Extensions dialog box which allows you 
to associate any arbitrary HTML attribute with this control.



Push Button Properties Dialog
In the web page editor, this dialog box is displayed when you create a push button control 
using the “  File | Form | Push Button  ”   menu command or when you edit an existing control 
by either double clicking on it or single clicking and choosing the “  Edit | Properties  ”   menu 
command.
The following fields are available under the “General” tab.
Type: Specifies the type of button.    The “Submit” type will cause the form contents to be 
submitted.    The “Reset” type will cause the form contents to be reset to their initial 
values.    The “Image” type is the same as the “Submit” type except you may specify a 
image that is to be displayed.
Image URL: If the type is set to “Image”, this field specifies the image to be displayed.
Alternate Text: If the type is set to “Image”, this field specifies the text to be displayed if 
the image is unavailable.
If you have set the type to “Image”, the Following fields are available under the “Image” 
tab.
Width: This field allows you to specify the width of the image in pixels.
Height: This field allows you to specify the height of the image in pixels.
Percent of line width: Check this box if you wish the width of the image to be set to a 
percent of the width of the line containing it.    The percentage is specifies in the “Horz. 
Scale” field.
Border: Specifies the thickness of the border which surrounds the picture.
Margins: Specifies the margins around the picture.
Alignment: Specifies the alignment for the picture as follows

Bottom The bottom of the picture is aligned with the baseline of the line
Top The top of the picture is aligned with the top of the line
Center The picture is centered vertically within the line
Left The picture floats to the left edge and text wraps around it. 
Right The picture floats to the right edge and text wraps around it.

Advanced: Click this button to bring up the HTML Extensions dialog box which allows you 
to associate any arbitrary HTML attribute with this control.



HTML Extensions Dialog
This dialog box allows you to specify a list of any arbitrary HTML attributes for an object.
Attribute: This list box displays a list of the attributes currently defined for the object.
Up: To move an attribute up in the list, select the attribute and click on this button.
Dn: To move an attribute down in the list, select the attribute and click on this button.
Add: Click this button to add a new attribute / value pair to the “Attributes” list via the “Set
Attribute” dialog box described below.
Remove: To remove an attribute, select the attribute in the list box and click this button.
Modify: To modify an existing attribute, select the attribute in the list box and click this 
button.    This will bring up the “Set Attribute” dialog box described below.

Set Attribute Dialog
Name: Specifies the name of the attribute.
Specify Value: Check this box if you wish to specify a value for the attribute.    The value 
is entered into the edit field below.



Image Map Dialog
This dialog allows you to edit client side image maps.
Map Name: Specifies the name of the map.
The list box to the left lists the areas currently defined for the image map.    The controls to
the right allow you to create, modify and delete areas.
Shape: Specifies the shape of the area, which may be “Default”, “Rectangular”, “Circular”, 
or “Polygon”.    Note that some browsers, (e.g. Netscape Navigator) do not support circular 
or polygon areas.
Coords: Specify the list of coordinates for the shape.    For a rectangle, there should be 
four numbers separated by commas.    The first two numbers specify (in pixels) the upper 
left hand corner of the rectangle, the next two numbers specify the lower left hand corner.
For a circle, there should be three numbers separated by commas.    The first two numbers
specify the position of the center of the circle.    The third is the radius.
For a polygon, there should be at least 6 numbers separated by commas.    The numbers, 
in pairs, represent the vertices of the polygon.
HREF: Specifies the URL for the area.    You can click on the button to the right to bring up 
the Create/Edit Link dialog box.
Frame: If you are using a frame based web site, you can specify the frame into which the 
page should be loaded.
Delete: To delete an area, select the area in the list box and click this button.
Add: To add a new area, select the shape, input the coordinates, HREF, and frame name, 
and then click this button.
Change: To change an existing area, select the area in the list box, change the attributes 
and then click this button.
Advanced: Click this button to bring up the HTML Extensions dialog box which allows you 
to associate any arbitrary HTML attribute with this image map.



Page Setup Dialog
This dialog box allows you to specify the page dimensions and margins to be used when 
web pages are printed.
Page Size: Choose from one of the standard paper sizes, or enter any custom page size.
Margins: Specify the page margins to use
Orientation: Choose either portrait or landscape page orientation.



Update Web Page Dialog
When updating web pages, if WebExpress detects a page which it did not create, this 
dialog box is displayed.    You may choose to update this page, but if you do, you should be
aware that the page will be loaded and saved.    This process can change the page in un-
expected ways.



New Web Page
Use the "File | New Web Page" command to create a new web page or HTML document.    
Choosing this command displays the “New” dialog box from which you can specify the 
default properties for the new page.    See the Web Page Properties help topic for more 
information on setting the properties for the page.
Remember that a title is required according the HTML specification, and some web 
browsers may not load the page without one.    It is also usually displayed as the window 
caption in most browsers.
See also: Web Page Properties

Keyboard Shortcut
New document CTRL+N



Open
Use the "File | Open" command to open an existing web page or HTML document.    
Choosing this command displays the "Open" dialog box where you can select from a list of
documents.
Open Dialog Box
The Open Dialog uses a standard Windows based dialog for you to select files, directories 
and navigate where your documents are stored. This dialog will differ between the 
Windows 3.1 version and the Windows 95 version.

Keyboard Shortcut
Open a document CTRL+O



Close
Use the “File | Close” command to close the document in the active window, and remove 
the window.      If the document has been changed since the last time it was saved, you will
be prompted to save the changes before the document is closed.

Keyboard Shortcut
Close a document CTRL+W



Save
Use the “File | Save” command to save the document in the active window.    If the 
document has not been previously saved, the Save As dialog will prompt you to specify a 
name the document.

Keyboard Shortcut
Save document CTRL+S



Save As
Use the “File | Save As” command to bring up the Save As dialog to which allows you to 
specify a name to use for the document when it is written to disk.    After a name has been
specified and the document is saved to disk, the document in the active window assumes 
this new name as well.



Save All
Use the “File | Save All” command to save all open documents to disk.    For any previously 
unsaved documents, the Save As dialog will prompt you to specify a name the document.



Print
Use the “File | Print” in the web page editor command to print the active document.    The 
following dialog will appear to allow you to specify how the document should be printed.

Print Dialog
Printer: Specify the printer to be used.
Print To File: Check this box if you wish to print to a file instead of the printer.
Copies: Specify the number of copies of the document you want to print.
Collate Copies: If you print multiple copies and you want the pages to be collated, check 
this box.    Otherwise, the multiple copies command of the printer (if it has one) will be 
used and all the copies of the first page will be printed followed by all the copies of the 
second, and so on.
Drop Pictures: Check this box if you wish to drop pictures while printing.    This can be 
used to speed up printing.
Page Setup: Click this button to bring up the “  Page Setup  ”   dialog box which allows you to
specify the size and margins of the page to be printed.
Printer Setup: Clicking this button will bring up the printer setup dialog box which allows
you to configure your printer.    The exact nature of this dialog box varies from printer to 
printer.



Printer Setup
Use the “File | Printer Setup” command in the web page editor to select the printer you 
wish to use with WebExpress.    



Exit
Use the “File | Exit” command to exit WebExpress.    If any open documents are currently 
changed since the last time they were saved, you will be prompted to save the changes 
before the document is closed.



Undo/Redo
Use the "Edit | Undo" command to reverse the effect of the last action you performed, 
such as typing, deleting or formatting text, inserting an image, table, etc.
The name of this command changes to reflect the exact nature of the action you want to 
undo.    For example, if you just deleted some text by selecting it and pressing the Delete 
key, the command name changes to "Unto Typing".    If you just formatted some text to 
Bold, the name changes to "Undo Format".    If you just inserted an image, the name 
changes to "Undo Insert Image".
Upon selecting an "Undo" command, the command changes to "Redo".    The "Redo" 
command lets you undo the last "Undo".

Keyboard Shortcuts
Undo or Redo CTRL+Z    or ALT+BACKSPACE



Cut
Use the "Edit | Cut" in the web page editor command to delete the selected text or objects
from your document and place it on the Clipboard where it can be pasted elsewhere in the
document, or to a different document.
Images and horizontal rules can be cut by select the first selecting the text around them.   
If all you want is the image or rule by itself, position the cursor just before the object and 
press the right arrow key while holding down the shift key.

Keyboard Shortcut
Cut CTRL+X or SHIFT+DEL



Copy
Use the "Edit | Copy" in the web page editor command to place a duplicate of the selected
text or objects onto the Clipboard where it can be pasted elsewhere in the document, or to
a different document.
Images and horizontal rules can be copied by first selecting the text around them.    If all 
you want is the image or rule by itself, position the cursor just before the object and press 
the right arrow key while holding down the shift key.

Keyboard Shortcut
Copy text or objects CTRL+X    or CTRL+INS



Paste
Use the "Edit | Paste" in the web page editor command to place the contents of the 
clipboard (the last text or object you cut or copied) back into the document, or to a 
different document.
Paste inserts the new text and/or objects at the current caret position.    If text is selected, 
paste will replace the selected text with the text on the clipboard.

Keyboard Shortcut
Paste text or objectsCTRL+V or SHIFT+INS



Select All
Use the "Edit | Select All" command in the web page editor to highlight, or select, all text 
in the document, or current table cell.    The text is then ready to be cut, copied or 
formatted.
TIP: Select all is particularly useful when you want to move data from one table cell to 
another.    Select all the text in the cell, cut it to the clipboard, switch to the destination 
cell, and paste the text.. 

Keyboard Shortcut
Select all text CTRL + A



Search
Use the "Edit | Search" command in the web page editor to search the document for 
specific text.

Search Dialog Box
Search For: WebExpress can search for any text you can enter from the keyboard. In this 
field, enter text you wish to find.    The pattern can be partial words or whole words.
Ignore Case:    By default, the Search command is not case-sensitive.    With Ignore Case 
off, or un-checked, WebExpress locates text exactly as you type it, looking for exact 
matches of upper and lower case letters.
Whole Word: Turn this option on to search for whole words.    Turn it off to allow the 
search to look in text embedded within words.
Backwards:    WebExpress can search forward (to the end of the document) or backward 
(to the beginning of the document) from the cursor location.
Find Next: Click the "Find Next" to begin the search.    If WebExpress cannot find the 
search text, it displays a message.    If this happens, you might want to change the 
direction of the search and click "Find Next" again.
Done: Click this button to close the "Search" dialog box.
Replace: Clicking this button changes the dialog box to the Replace dialog box, where 
you can choose to replace the search text with replacement text you specify.

Keyboard Shortcut
Search CTRL+F



Replace
Use the "Edit | Replace" command in the web page editor to search the document for 
specific text and replace it with different text.
Search Dialog Box
Search For: WebExpress can search for any text you can enter from the keyboard. In this 
field, enter text you wish to find.    The pattern can be partial words or whole words.
Replace With: Specify the text you wish to replace the matched text.    Keep in mind that 
the text will be replaced in the same case as you enter it.
Ignore Case:    By default, the Search command is not case-sensitive.    With Ignore Case 
off, or un-checked, WebExpress locates text exactly as you type it, looking for exact 
matches of upper and lower case letters.
Whole Word: Turn this option on to search for whole words.    Turn it off to allow the 
search to look in text embedded within words.
Backwards:    WebExpress can search forward (to the end of the document) or backward 
(to the beginning of the document) from the cursor location.
Start: Click the "Start" button to begin the search.    If WebExpress cannot find the search 
text, it displays a message.    After the first word is found, this button changes to “Skip”.    
Pressing this button subsequently will cause the currently matched word to be skipped for 
replacement and will look for the next occurrence.
Replace: Click the "Replace" button to replace the currently matched word with the text 
in the "Replace With" field.    Searching will then continue looking for the next occurrence.
Replace All: Click the "Replace All" if you want to replace all occurrences of the specified 
word.    This is useful when you are sure you want to make the replacement, and there are 
many occurrences or you have a long document.
Done: Click this button to close the "Search" dialog box.

Keyboard Shortcut
Replace CTRL+H



Find/Replace Next
Use the “Edit | Find Next” command in the web page editor to repeat the last Search 
command you issued. WebExpress searches for the next occurrence of the text you 
entered in the Search dialog box.
If you have just performed a Replace command, the Find Next command changes to 
Replace Next. Choosing it displays the Replace dialog box after it has located the search 
text.

Keyboard Shortcut
Find/Replace Next F3



Go To Bookmark
Use the “Edit | Go To Bookmark” command in the web page editor to go to a bookmark 
defined in the current document.    Bookmarks in WebExpress are used to mark 
destinations for hyper links in your web pages.    Bookmarks must first be inserted into 
your document with the “  Insert | Bookmark  ”   command.

Go to Bookmark Dialog
Select from one of the existing bookmarks in your document.    To create bookmarks, use 
the Insert/Bookmark command.    Bookmarks are used as destinations for hypertext links 
within your document.
See Also:    Insert | Bookmark, Insert Link

Keyboard Shortcut
Go To F5



Go To Current Bookmark / Load Web Page
If you have created hyper links to bookmarks within your web page, you can jump directly 
to them, much as a browser would do when someone clicks on the hypertext on the Web.   
To do so:

1. Position the cursor within the hyper text.
2. Choose Go To Current Bookmark from the Edit menu.

If you have a link to another file in your web site, then this command will change to “Load 
Web Page”.    In this case, choosing this command will load the specified web page into 
another web page editor window.    If the page does not exist, you will be asked if you wish
to create it.
See also “  Insert | Link  ”  



Edit Properties
Use the “Edit | Properties” command in the web page editor to edit the properties of an 
object.    WebExpress allows you to create various types of objects which have properties 
unique to them.    They include Images, Tables and Horizontal Rules.    When you are in a 
table, or have an image or horizontal rule selected, this command will be available in its 
proper context.    For example, when you are editing a table, this command will show ‘Table
Properties’.
See also: Table Properties, Image Properties, Horizontal Rule Properties, Text Box 
Properties, Check Box Properties, Radio Button Properties, Drop Down Menu Properties, 
Push Button Properties, and Form Properties.



Web Page Properties
Use the “Edit | Web Page Properties” command in the web site editor to specify the 
characteristics of your web page.

Web Page Properties Dialog
Title: Specifies the title for your web page.    This will be displayed by most browsers as 
the window title when they are viewing your pages.
Base URL: Specifies the base URL for where the web page is located.    This field is 
optional and is seldom used.
Background Color: You can choose the color for the background of your web page. The 
first entry allows you to specify the default background color used by a browser.    All other
choices will explicitly set the background color.    
If you specify a background image, the background will not be seen.
Background Image: Specifies an image to use as the background for your page.    The 
image will be tiled if necessary to cover the entire page.
Text Color: You can choose the color in which your text will be displayed by default for 
your web page.    The first entry allows you to specify the default text color used by a 
browser.    All other choices will explicitly set the text color.
Link Color:    You can choose the color in which hypertext links will be displayed.    The 
first entry allows you to specify the default hypertext link color used by a browser.    All 
other choices will explicitly set the hypertext links color.
Viewed Link Color:    You can choose the color in which hypertext links will be displayed 
after the user has visited the link.    The first entry allows you to specify the default viewed
hypertext link color used by a browser.    All other choices will explicitly set the viewed 
hypertext link color.
Sound/Music: You can specify a background sound which will be played by a browser 
when someone visits your web page.



Preferences
Use the “Edit | Preferences” command to set the default characteristics for many items 
within WebExpress.    They fall into two main categories: General and Table.

Preferences Dialog

General
Text Color: Sets the default text color to be used when creating new web pages.
Background Color: Sets the default background color to be used when creating new web
pages.
Link Color: Sets the default link color to be used when creating new web pages.
Viewed Link Color: Sets the default viewed link color to be used when creating new web
pages.
Default View Options: Sets the default value for the items appearing on the View Menu.
Use New Windows: Allows you to choose whether you want WebExpress to always 
create a new window when opening or creating documents.    The default is turned on.

Tables and Images
Default Table Width Options:  Set the default behavior for the width of tables when 
creating new tables.    See also: Table Properties
Default Cell Width Options:  Set the default behavior for the width of tables when 
creating new tables.    See also: Cell Properties
Search Path for Local Images: Enter the name of folders WebExpress should search 
when looking for images to display when editing web pages.    You can specify the folders 
to be either relative to the location of the document, or as a complete path.    You can 
specify multiple folders in which to search by separating each with a semi-colon.
Example:    c:\images;images.
In this example, it would first search the folder in which the document resides.    Next it 
would search the images folder on the C: drive.    Finally, it would search the images folder 
directly beneath the folder in which the document resides.
Note: HTML documents specify where to find images on the Web, not on your hard disk.    
Therefore, WebExpress uses the search path to find the images on your hard disk based 
on the filename used when looking on the Web.    If you always store your images in the 
same directory as your HTML documents, there is no need to set this preference, as they 
will always be found. 



Show Table Grids
Table grid lines outline the dimension of table cells.    It is very useful to have table grid 
lines turned on when editing a document, so that you can visually observe how the cells 
relate to one another.    To see your web page as it will appear in a browser, you can turn 
them off.
Use the “View | Show Table Grids” command in the web page editor to toggle how the 
tables appear in the current document.    When a check mark appears next to the 
command, grid lines are displayed.    When no check mark appears, no grid lines are 
displayed.
Tip: To change the default setting for table grid lines when documents are opened or 
created, see Preferences.



Show Paragraph Breaks
Use the “View | Show Paragraph Breaks” command in the web page editor to toggle on or 
off the display of paragraph markers in the current document.    When a check mark 
appears next to the command, a marker is displayed at the end of each paragraph.    
When no check mark appears, no grid lines are displayed.
Tip: To change the default setting for paragraph breaks when documents are opened or 
created, see Preferences.



Show HTML Field Markers
HTML Field markers allow you to see where embedded HTML elements and comments 
appear in your documents.    Embedded HTML elements are codes used as extensions to 
the HTML, in cases where WebExpress may not provide adequate support. You can insert 
them in your code using the Insert/HTML Element command.    
Comments were mainly used by HTML programmers who had to maintain their pages in a 
text editor.      They used them as a reminder of techniques and why they were used .    
Thank goodness in WebExpress, you no longer need to worry about them.
When HTML Field Markers are turned on, comments appear in the text as <C>, and 
elements appear in the text as <E>.    You can double click on these to edit them.
Use “View | Show HTML Field Markers” command in the web page editor to toggle whether 
HTML field markers are displayed in the current document.    When a check mark appears 
next to the command, the markers are displayed.    When no check mark appears, the 
markers are hidden.
Tip: To change the default setting for HTML field markers when documents are opened or 
created, see Preferences.



Show Control Strip
The Control Strip is the tool bar which contains settings for Paragraph Style, Font, Font 
Size, Text Color, and Text Alignment.    The Control Strip typically appears just above the 
main window.    The Control Strip is either on or off for the entire application.
Use “View | Show Control Strip” command to toggle whether the control strip is visible.    
When a check mark appears next to the command, the Control Strip is visible.    When no 
check mark appears, the Control Strip is hidden.
Tip: The Control Strip can be positioned at the top or bottom of the window, or it can be 
free floating like a non-modal dialog.    To change its position, click in the Control Strip 
outside of any of its controls and drag it to its new location.    When you are at the top or 
bottom of the window, it will snap into place.



Show Status Strip
The Status Strip appears at the bottom of the main window, and shows useful information 
about many activities. 
Use the “View | Show Status Strip” command to toggle whether the status strip is visible.    
When a check mark appears next to the command, the Status Strip is visible.    When no 
check mark appears, the Status Strip is hidden.



Show Speed Tools
The Speed Tools bar contains quick access to many common commands.    In come cases, 
these are merely shortcuts to the menus, and in others, they are special commands to 
quickly facilitate a task. Speed Tools are either on or off for the entire application.
Use the “View | Show Speed Tools” command to toggle whether the speed tools are visible. 
When a check mark appears next to the command, Speed Tools are visible.    When no 
check mark appears, Speed Tools are hidden.
See Also: Customize Speed Tools



Character Formatting
Use the “Format | Character” command in the web page editor to change the 
characteristics of text.    If you have text selected, this command will apply these 
characteristics to the selection.    If you do not have text selected, this commands sets up 
the pending characteristics to be used when you return to entering text.
Tip: Although different browsers have different levels of support for character formatting, 
both Microsoft and Netscape support all the formatting commands included here.
See also: Format Character Dialog



Paragraph
Use the “Format | Paragraph” command in the web page editor to change the appearance 
of paragraphs in your document.    This command will affect the paragraph at the current 
caret position, or for a range of selected paragraphs.    
See also: Paragraph Formatting



Bold
Use the “Format | Bold” command in the web page editor to bold the selected text or sets 
the pending style to bold for use when entering text.    Note that in paragraphs where the 
paragraph style dictates that the text is bolded, and therefore cannot be turned off.    The 
Heading styles are examples of such paragraph styles.



Italic
Use the “Format | Italic” command in the web page editor to italicize the selected text or 
sets the pending style to italic for use when entering text.    Note that in paragraphs where
the paragraph style dictates that the text is italicized, and therefore cannot be turned off.   
The Address style is an example of such a paragraph style.



Underline
Use the “Format | Underline” command in the web page editor to underline the selected 
text or sets the pending style to underline for use when entering text.    Note that 
hypertext links always appear to be underlined.



Revert to Style
Use the “Format | Revert to Style” command in the web page editor to return all text in the
selection back to the default characteristics as defined by the paragraph style.



New Paragraph
Use the “Format | New Paragraph” command in the web page editor to control the space 
before paragraphs.    When checked, space is added before a before a paragraph.    This is 
the normal setting for paragraphs created when pressing Enter.    In lists, this is normally 
turned off, allowing the items in the list to be grouped more closely.    
For HTML aficionados, this is the typically the difference between a New Paragraph and a 
Break, also known as <P> or <BR>.    If this is checked, it guarantees that a break will not 
be used.



Lists
Use the “Format | List” commands in the web page editor to create and manage different 
types of lists.    Lists can appear with bullets, numbered, or plain.    Lists are indented, and 
can be multi-leveled.

List None
This command turns off the bullet or number on the current list item.    It remains a part 
of the list, and the numbering or bullets will resume on the next item in the list with the 
attribute set.

List Numbered
Creates a list which automatically numbers each item in the list.    

List Bulleted
Creates a list which places a bullet in front of each item in the list.    

List Directory
Creates a list which places a bullet in front of each item in the list.    Note that the bullet 
characters used by most browsers use identical symbols for bulleted, directory, and 
menu lists.

List Menu
Creates a list which places a bullet in front of each item in the list.    Note that the bullet 
characters used by most browsers use identical symbols for bulleted, directory, and 
menu lists.

Definition Term
Creates a definition list term which is not indented.

Definition List
Creates a definition list which is indented with no bullets.

Promote List
Promotes a list item to the next level, thus creating a multi-leveled list.    Numbered lists 
restart the numbering on the new level.    Bulleted lists use different bullet symbols for 
each level.

Demote List
Demotes a list item to the previous level, thus resuming the previous level in a multi-
leveled list.    In a single leveled list, or at the first level of a multi-leveled list, this 
effectively ends the list and returns to the body of the document or table.



Hypertext Links
Use the “Insert | Link” command in the web page editor to create and edit hypertext links 
within your documents.    You can add links to locations within your document marked with
bookmarks, links to local pages within your web site, links to external HTML documents, 
and links to your e-mail address so that readers can send you messages.    The Link dialog 
box has three tabs, one for each of these types of links.    To clear a link, use the “  Insert |   
End Link  ”   command.

Local Page:
This tab allows you to add links to locations within the document you are currently editing,
or to another page within your web site.
Select page / bookmark from list: Select the page and/or bookmark from the list.    This
first element ‘(Current Page)’ contains a list of all the currently defined bookmarks in your 
document.    To expand the list, double click on the icon to the left.    To link to a bookmark, 
simply double click on the bookmark, or select the bookmark and click ‘OK’.
If you are using the Web Site Manager, then this list will also contain a list of all of the 
pages in your web site.    To add a link to one of the pages, simply double click on the 
page, or select the page and click ‘OK’.    If a page has bookmarks within it, double clicking 
on the page will display the list of bookmarks.    To link to one of the bookmarks, double 
click on the bookmark or select the bookmark and click ‘OK’.
Page: If the page to which you wish to link has not been created yet, you can add the 
page now.    Type in the name for the new page and press Add.    This will add the new 
page to the list of pages.
Bookmark:    If you have not yet defined the bookmark in a document, you can add the 
reference now.    Type in the name you intend to use for the bookmark, and press Add.    
This will add the new bookmark reference to the list.    If the bookmark is in the current 
document, leave the Page field blank.    If the bookmark in another page, enter the page 
name in the Page field, or click on the correct page from the list.    Important: for the link
to actually work, you will need to remember to define the target for the bookmark in the 
document.    To do this, use Insert/Bookmark.
Tip: One common use of these types of links is to have a hypertext jump at the bottom of 
your document jump back up to the top.    Another is to create a table of contents at the 
top of the page of points of interest found further down on the page.    Both allow readers 
of the page to quickly find their topic of interest, without scrolling up and down.

WWW URL:
This tab allows you to add links to locations in other documents on the Web.    This is the 
most common type of link used in most web pages.
Select URL from List: This list contains the URLs from all the external links currently 
found in your document.      It also contains any URLs you have saved on your permanent 
URL list (see below), and any that have been used during the current editing session, 
whether or not they still actually are used in a hypertext link.
If a URL also contains bookmarks to locations within it, the URL appears as a folder which 
can be opened or closed by double clicking on it.    When it is open, it shows the 
bookmarks for the URL.    When it is closed, it hides the bookmarks.



If the URL you wish to use is in the list, select it and press OK. You can also double-click on
an item to select and accept it in one step.
URL: If the URL to which you wish to link is not in the list, you can add one now.    Type in 
the URL, preceded by the protocol it uses (e.g. http:// or ftp://, if you do not enter a 
protocol, ‘http://’ will be assumed).    Press Add when you are ready to add it to the list.
Bookmark: When adding the URL to the list, you can also specify a bookmark to which 
the link should position within the new web page.    Type in the name of the bookmark for 
the URL before adding the URL to the list.
Save on Permanent URL List: When you add URLs to the list, you can specify that they 
are saved on a permanent list.    This allows the URL to be available on this list at all times,
even when there are no hypertext jumps yet defined in your document.
Tip: Save the URL for the home page of your web site on the permanent list.    Then when 
you create supplemental pages, you can easily place a link back to your home page in 
every document.

E-Mail Address:
This tab allows you to add links to e-mail addresses, so that readers or customers can 
contact you for further information or communication.    When used, E-mail links 
automatically insert a mailto link in your document, so that browsers know that the 
readers e-mail application should be launched in response to the link being selected.
Select E-Mail Address    from List: This list contains all the e-mail addresses from links 
currently found in the document. It also contains any e-mail addresses you have saved on 
your permanent e-mail list (see below), and any that have been used during the current 
editing session, whether or not they still actually are used in a hypertext link. 
If the e-mail address you wish to use is in the list, select it and press OK. You can also 
double-click on an item to select and accept it in one step.
E-Mail Address: If the e-mail address to which you wish to link is not in the list, you can 
add one now.    Type in the e-mail address.    Press Add when you are ready to add it to the 
list.
Save on Permanent E-Mail List: When you add e-mail addresses to the list, you can 
specify that they are saved on a permanent list.    This allows the e-mail address to be 
available on this list at all times, even when there are no hypertext jumps yet defined in 
your document.
Tip: Save the your e-mail address on the permanent list, as well as any that are 
commonly used such as info@address or support@address.    Then when you create 
supplemental pages, you can easily place a link to these addresses in your documents.



End Link
If you wish to clear a link, select the text (or picture) which specifies the link and then 
choose the “Insert | End Link” command.



Bookmarks
Use the “Insert | Bookmark” command in the web page editor to mark a location within 
your document as a destination point for hypertext links.    Bookmarks can be added 
anywhere within a document, but are typically associated with the beginning of a new 
section or subject matter.

Insert Bookmark Dialog
To insert a bookmark simply type it's name in the space provided. Bookmarks can be 
deleted by highlighting the bookmark with a mouse in this dialog and clicking on the 
delete button.
You can jump to a bookmark by using the "Go To" entry on the Edit menu. 
See Also: Go To Bookmark, Hypertext Links

Keyboard Shortcut
Bookmark F5



Image
Use the “Insert | Image” command in the web page editor to insert images and pictures 
into your document.    Images are inserted into the text stream, which can be located 
within the body of the document or in a table cell.    WebExpress currently allows you to 
insert GIF and JPEG images, the two most popular formats found on the Internet and 
supported by all major browsers.

Image Dialog
You can edit many of the properties of your picture with this dialog.    There are three 
major areas that can be modified: Properties, URL, and Image Maps.

Properties:
Size: You may specify the width and height of an image as either an absolute value or as 
a percent of it’s original size.
Set: This option for both the width and height tells WebExpress whether the width and 
height values should be written out to file.    In some circumstances, this may be desirable. 
For example, if the image is an on an external web site and you don’t know its dimensions,
it is best to leave these values unset and allow the browser to determine the image 
dimensions.
Percent of line width: Check this box if you want the width of the picture to be a 
percentage of the width of the line in which it appears.    In this case, the Horz Scale field 
specifies the percentage.
Maintain Aspect Ratio: Checking this will force any changes to either the width or 
height to maintain the original ratio between width and height.
Border: You can set a border by entering a value in this field.    It is an index beginning 
with 1, with the greater the index the thicker the border.
Note: Netscape will always display a border if one is set.    Microsoft Explorer will only 
display the border if the image is also a hypertext link.    WebExpress always displays the 
border, so that you are aware one is set.
Margins: Both horizontal and vertical margins can be added to create extra white space 
around the image.    They are specified as an index beginning with 1, with the greater the 
index the larger the margin.
Alignment: Images are inserted at a location in the text.    They can be aligned vertically 
to the top, middle or bottom of the line at which they are inserted.    Alternatively, they 
can be aligned horizontally to the left or the right of the line.    
When images are aligned left or right, a marker is placed in the text so that you can see 
its insertion point in the text.    The vertical alignment depends on where it is inserted in 
the paragraph.    If it is at the beginning of the paragraph, the image is aligned    to the top 
of the first line.    Otherwise, the image is aligned to the bottom of the line on which it is 
inserted.

URL:
High Resolution URL: This specifies where the browser will look for the image.    You can 
specify an absolute URL, or a relative one.    For example, if you keep the image in the 
same directory on your web site as the web page itself, you can simply specify the file 



name of the image.    The browser will automatically find it there.
Note: WebExpress always looks for images to be in the same directory as the web page for
displaying while editing.    We recommend that you copy any images you plan to use into 
this directory when creating your documents.
File: Allows you to specify a file from your computer which will be used on your web page.
Remember that you will have to upload this image file with the web page to your web site.
WebExpress currently supports GIF and JPEG file formats.
Low Resolution URL: An alternative URL for a low resolution alternative image.    This is 
seldom used, and is rarely necessary.
Alternate Text: This provides a place to put a textual description for the image for 
people viewing your web page with a text browser.    It is a good idea to add text here, 
even though it is becoming more rare that people use text browsers to surf the web.
Extensions: Click this button to bring up the “  HTML Extensions  ”   dialog box which let you 
add HTML attributes to the picture.

Image Maps:
You can setup a map for your image.    The map can be Server side or Client side.    You can
select an existing map either in the current page, the web site, or in another web page, or 
you can create a new map in the current file.    
Note: Using a map that is in a different file will not work in some browsers (e.g. Netscape 
Navigator).    If you want to have a single map which is used in multiple files, we suggest 
that you store the map in the web site.    If you change a map stored in the web site, then 
whenever a file using that map is loaded and saved, the map will be automatically 
updated.    In addition, the “  Edit | Update Web Pages  ”   command in the web site manager 
can be used to automatically update all pages which use maps in the web site.



Insert Table
Use the “Insert | Table” command in the web page editor to insert tables into your 
document.    Tables can be inserted into the body of the document or in a table cell.    
Tables are the most powerful tool offered in HTML by which you can precisely layout the 
page of your document.

The New Table Dialog
Type in the values for the number of rows an columns required. Note that later on you can 
edit these and add in more rows or columns as required. At this point you should 
approximate your requirements if you are unsure. 



Horizontal Rule
Use the “Insert | Horizontal Rule” command in the web page editor to insert a horizontal 
rule between paragraphs within your document.    Horizontal rules are useful to logically 
separate blocks of text by subject matter.    To edit its properties, click on the rule to select
it, the click with the right mouse to bring up its properties menu.    Select Edit Properties 
from this menu.
See Also: Horizontal Rule Dialog



Symbol
Use the “Insert | Symbol” command in the web page editor to insert a symbol character or 
a character not found on your keyboard into your document.

Insert Symbol Dialog
Font: Specifies whether you wish to display all characters or only special characters.
Insert: To insert a character into you document, double-click on the desired character or, 
single click on the character and then click this button.
Close: The “Insert Symbol” window will remain open allowing you to insert multiple 
characters.    Click this button to close the window.



HTML Element
Use the “Insert | HTML Element” command in the web page editor to insert comments or 
arbitrary HTML codes into your document.

HTML Element Dialog
Type: Specifies whether this is a comment or element.
Enter the comment or commands into the list box below.
Note: WebExpress does not attempt to verify the syntax of any commands entered with 
this command.    To ensure that they work properly, you should be familiar with HTML 
coding, and they should be tested in your target browser.



Clear Left
Use the “Insert | Clear Left” command in the web page editor insert a new paragraph at 
the current caret position and sets the clear left attribute in the new paragraph.    Note 
that if you have text selected, the selected text is replaced when the new paragraph is 
inserted.
The Clear left attribute forces the paragraph to move below any pictures on its left.    This 
effectively eliminates the paragraph from aligning to the left of an image which was 
inserted in a previous paragraph.



Clear Right
Use the “Insert | Clear Right” command in the web page editor to insert a new paragraph 
at the current caret position and sets the clear right attribute in the new paragraph.    Note
that if you have text selected, the selected text is replaced when the new paragraph is 
inserted.
The clear right attribute forces the paragraph to move below any pictures on its right.    
This effectively eliminates the paragraph from aligning to the left of an image which was 
inserted in a previous paragraph.



Clear Both
Use the “Insert | Clear both” command in the web page editor to insert a new paragraph at
the current caret position and sets the clear right and clear left attributes in the new 
paragraph.    Note that if you have text selected, the selected text is replaced when the 
new paragraph is inserted.
The combined attributes force the paragraph to move below any pictures, left or right.    
This effectively eliminates the paragraph from aligning along side an image which was 
inserted in a previous paragraph.



Insert Rows
Use the “Table | Insert Rows” command in the web page editor to insert rows into a table.    
Specify the number of rows you wish to insert.



Insert Columns
Use the “Table | Insert Columns” command in the web page editor to insert columns into a 
table.    Specify the number of columns you wish to insert.



Select Table
Use the “Table | Select Table” command in the web page editor to select all cells in the 
table.    If the table is inserted into a table cell rather than the body of the document, it 
does not also select the table in which it is inserted.



Select Rows
Use the “Table | Select Rows” command in the web page editor to select all cells in a table 
row.    If the cells are currently selected which span over one or more rows, all rows will be 
selected.



Select Columns
Use the “Table | Select Columns” command in the web page editor to select all cells in a 
table column.    If the cells are currently selected which span over one or more columns, all
columns will be selected.



Span Cells
Use the “Table | Span Cells” command in the web page editor to combine all selected cells 
in a table into one cell occupying the same physical space. Spanned cells can give the 
table the appearance of non-symmetrical rows and columns.    This is extremely useful 
when laying out a page which mixes images and text.    
Note that when the table cells are combined, only the data in the top left cell will be 
visible.    You will not lose the data in the other cells, but it will not be visible or accessible 
to you as the editor.    Therefore, it is often a good idea to arrange your table by spanning 
cells before the data has been entered.    



Split Cells
Use the “Table | Split Cells” command in the web page editor to restore cells which had 
previously been spanned back to their original configuration.    This command is not 
accessible unless you are currently editing a spanned cell, or have spanned cells (and only
spanned cells) selected.



Spell Check
Use the “Utilities | Spell Check” command in the web page editor to remove any typing 
errors from your documents.    You will first be asked what portion of the document you 
wish to check via the Spell Check Start dialog box.    If a misspelled word is found, you can 
correct using the Spell dialog box.
See Also: Spell Check Dialog

Keyboard Shortcut
Spell Check F7



Customize Speed Tools
Use the "Utilities | Customize Speed Tools" command to configure the speed tool palette.    
You can choose which speed tools appear on the palette, as well as their order.    The 
"Customize Speed Tools" dialog box is displayed:

Customize Speed Tools Dialog Box
Tools: Select from this list of tools to add to or remove from the tool palette.
Default: Click this button to install the default set of tools.
Add: Click this button to add the currently selected tool to the palette.    If the tool is 
currently on the palette, this button will be grayed.
Add All: Click this button to add all of the tools to the palette.
Remove: Click this button to remove the currently selected tool from the palette.    If the 
tool is not currently on the palette, this button will be grayed.
Remove All: Click this button to remove all of the tools from the palette.
Position: Choose the palette's position.    The palette may be positioned along the top, 
bottom, left edge or right edge, or may be floating.
Done: Click this button when all modifications are complete.
Configuring the tool palette with the mouse
Display the "Customize Speed Tools" dialog box either by choosing "Customize Speed 
Tools..." from the Utilities menu or double clicking on the speed tools palette.
You can then add tools to the palette with the mouse by clicking on the tool icon below the
"Add All" button and dragging the tool over to the palette.      You can remove tools from 
the palette with the mouse by clicking on any tool on the palette and dragging it off the 
palette.    You can re-arrange the order of tools on the palette by clicking on any tool on 
the palette and dragging it to a new position.
Click "Done" when all modifications are complete.

Keyboard Shortcut
Customize Speed Tools ALT+U,U.



Cascade
Use the “Window | Cascade” command to arranges all non-minimized document windows 
in a cascade fashion starting in the upper left corner of the workspace and moving down 
and to the right



Tile
Use the “Window | Tile” command to tile all non-minimized documents so all are visible 
simultaneously



Arrange Icons
Use the “Window | Arrange Icons” command to Arrange all the icons which represent 
minimized documents.



Close All
Use the “Window | Close All” command to close all open web page documents



Purchase
WebExpress Order Form
MicroVision Development, Inc. (United States)
Use this form for easy ordering.    Use File/Print Topic from the menu to print this form.    To 
order in England, see the Thompson Partnership Order form.

Payment Methods
You can order directly from MicroVision Development using your credit card or check 
drawn on a US bank.    MasterCard, VISA and American Express are all welcomed.

How to Order
When using a credit card, please select the most convenient method for placing your 
order.    Once the order has been received, your copy will go out the following day or 
sooner.

(800) 998-4555 Toll Free (U.S. Orders Only)
(760) 438-0305 Voice
(760) 438-7406 Fax
75201,2104 CompuServe Email
info@mvd.com Internet Email
www.mvd.com World Wide Web

To order by mail with a check or credit card, please send your order to:
MicroVision Development, Inc.
P.O. Box 3010
Carlsbad, CA 92009
USA

Order Information
______  Copies of WebExpress @ 69.95 $___________
CA Residents add Sales Tax $___________
Shipping/Handling ($5.00 US/$16.00 Intl) $___________
Total $___________

Customer Information
Name ___________________________________________________________
Company ___________________________________________________________
Address ___________________________________________________________

___________________________________________________________
City ___________________________________________________________
State/Prov. ___________________________________________________________
Country __________________      Zip / Postal Code    ______________________



E-mail ____________________________________________________________
Telephone: ____________________________________________________________
Credit Card: _______________________________________      Exp. Date    ________
 (When ordering with a credit card, be sure to include the billing name and address of the 
cardholder.)
Copyright © 1996 MicroVision Development, Inc.





Order Form - England
WebExpress Order Form                                      
The Thompson Partnership (United Kingdom)
Use this form for easy ordering.    Use File/Print Topic from the menu to print this form.

Payment Methods
You can order from The Thompson Partnership by payment with cheque or credit card.    
The credit cards accepted are: MC, Visa, Diner's Club and American Express.

How to Order
When using a credit card, please select the most convenient method for placing your 
order.    Once the order has been received, your copy will go out the following day or 
sooner.

Telephone Orders: 44 (0) 1889 564601
Fax Orders: 44 (0) 1889 563219
Internet Orders: sales@ttp.co.uk
Internet Support: support@ttp.co.uk

To order by mail with a check or credit card, please send your order to:
The Thompson Partnership
Lion Buildings
Market Place,
UTTOXETER
Staffordshire, England
ST14 8HZ

Order Information
______ Copies of WebExpress @ £49.00 £___________

V.A.T @ 17.5% £___________
Shipping/Handling £3.00

Total £___________

Customer Information
Name ___________________________________________________________
Company ___________________________________________________________
Address ___________________________________________________________

___________________________________________________________
City ___________________________________________________________
State/Prov. ___________________________________________________________
Country __________________      Zip / Postal Code    ______________________
E-mail ____________________________________________________________



Telephone: ____________________________________________________________
Credit Card: _______________________________________      Exp. Date    ________
 (When ordering with a credit card, be sure to include the billing name and address of the 
cardholder.)
Copyright © 1996 MicroVision Development, Inc.



Registering WebExpress
Once you’ve purchased your copy of WebExpress, you will receive a registration code 
which will enable full functionality to your evaluation copy.    The registration code is based
off the WebExpress product ID and the name you give when you order WebExpress.    We 
recommend that you write down the code in a safe place in case you need to later install 
WebExpress on a different computer.
Once you’ve purchased WebExpress and entered your registration code, you are entitled 
to free updates for WebExpress, up until the next major upgrade.    Check our Web site at 
www.mvd.com from time to time to find out the latest release of WebExpress, and what’s 
changed in the new version.
See Also: Ordering WebExpress



About
Information about WebExpress.



Spell Check Start
This dialog box allows you to choose whether you want to check the spelling of the entire 
document, from the caret position to the end of the document, or the current selection (or 
word if no text is selected),



Spell Check Dialog
The spell check dialog allows you a variety of options during a spelling check. Each of the 
options is on a button.
Change: Changes the mis-spelling to the one in the Change-To box.
Change All: This makes the current change and then changes every subsequent 
occurrence of the same error.
Ignore: Ignore the mistake on this occasion.
Ignore All: Ignore all occasions when this mistake is discovered.
Stop: Stop the spell check immediately.
Add Word: Add the current word to the dictionary.
Undo Last: Undo the last command.
Note: You can type your own changes into the "Change To:" box.



Format Paragraph Dialog
Use the "Paragraph..." command to change the paragraph formatting attributes of 
selected text, or to set the attributes for the paragraph containing the cursor.    Paragraph 
formatting attributes are applied to entire paragraphs, rather than single characters or 
words.    Alignment, indents, and paragraph style are examples of paragraph formatting 
attributes.
Paragraph Style: Select from a list of paragraph styles which are recognized by most 
browsers.    Selecting one of these styles can affect the font and size used for text in this 
paragraph, as well as set any of the other paragraph attributes.
Alignment: Choose options from the list to apply left or right alignment to a paragraph, 
or to center or justify it.
New Paragraph: This adds space above the paragraph. This is the normal setting for 
paragraphs created when pressing Enter.    In lists, this is normally turned off, allowing the 
items in the list to be grouped more closely.    
For HTML aficionados, this is the typically the difference between a New Paragraph and a 
Break, also known as <P> or <BR>.    If this is checked, it guarantees that a break will not 
be used.
Clear Left: The Clear left attribute forces the paragraph to move below any pictures on 
its left.    This effectively eliminates the paragraph from aligning to the right of an image 
which was inserted in a previous paragraph.
Clear Right: The Clear right attribute forces the paragraph to move below any pictures 
on its right.    This effectively eliminates the paragraph from aligning to the left of an 
image which was inserted in a previous paragraph.
Indent Level: You can specify that the paragraph is indented on both the left and right 
sides.    This is done with indent levels, with each level an increasing amount of 
indentation.    The actual amount of indentation can vary slightly from browser to browser.  
This is also called Block Quotes in HTML terminology.
List Type: Select a list type from a list of standard types recognized by most browsers.    
Numbered lists automatically increment with each successive paragraph.    
List Level: Specifies what level at which the list should be set.    This affects the level of 
left indent the list will appear at, as well as the type of bullet displayed.    In numbered 
lists, the start of each level also restarts the numbering.

Keyboard Shortcut
Paragraph CTRL + M



Format Character Dialog
The Character dialog allows you to specify the attributes for text in your document.    
Typeface: Currently you can choose between two typefaces for text displayed by 
browsers.    Normal text uses a proportionally spaced font.    On most Windows systems, 
the default Normal font uses Times New Roman.    Typewriter text uses a monospaced font.
On most Windows systems, the default Typewriter font uses Courier New.    Users can 
generally set this to be anything they want in their browsers, however.
Size:    HTML allows you to specify the size of text as an index between 1 and 7, where 1 is
the smallest text, and 7 is the largest.    We have chosen our set of actual point sizes used 
to closely match those used in the default size for browsers.
Color: You can choose the color in which your text will be displayed.    The first entry 
(default) allows you to that the text should use the default text color for the page, as 
defined in Web Page Properties.    All other choices will explicitly set the text color.
Bold: Turns on the bold character attribute.
Italic: Turns on the italic character attribute.
Underline: Turns on the underline character attribute.
Strikethrough: Turns on the strikethrough character attribute.
Blink: Turns on the blink character attribute.    Note that this is displayed in WebExpress 
as all uppercased text.
Superscript/Subscript: Turns on the appropriate character attribute.    Note that only 
one of these can be turned on at a time, or neither.



Horizontal Rule Properties
This dialog allows you to specify the attributes of horizontal rules.
Width: You can specify the width of the rule as either a percentage of the width of the 
screen or table cell, or as a fixed number of pixels.
Height: Specifies the thickness of the rule.    It is specified as an index beginning with 1, 
with the thickness greater the higher the number.
3D Look: Specifies the rule to be drawn in the default color, and with a three dimensional 
look to it.    You can turn this off if you would like a solid rule, or one that can be specified 
as a color.
Color: For non-3D rules, you can specify the color in which the rule is drawn.

Note: As opposed to Microsoft Explorer, Netscape currently does not support non-3D 
rules.    Furthermore, Netscape uses the background color of the page when drawing its 3D
rules.    Therefore, WebExpress does not always display rules exactly as they look in 
Netscape.    



Table Properties
You can specify the characteristics for your table here.
Width Options: You can specify the width of your table as a percentage of the screen 
size or table cell, absolute pixels or neither.    If you set the width in pixels, browsers will 
use this value as an absolute width for the table.    If you specify it as a percentage of the 
screen or table cell, the table will grow or shrink as the screen grows and shrinks.
If you specify neither, the size of the table is determined by a complex set of rules.    Most 
browsers behave similarly, and WebExpress does as well.    The behavior while editing may
seem somewhat unexpected, but the results are accurate.    Keep in mind, however, that 
you are not really in control of the size or dimension of the table using this option.
Border Thickness: Table borders are specified with as an index beginning with 1, with a 
higher index indicating a thicker border.    A thickness of 0 indicates no border.
Grid Thickness: The grid lines in the center of table borders are specified with as an 
index beginning with 1, with a higher index indicating a thicker border.    All tables with 
borders have grid lines, and as such thickness of 0 indicates very thin grid lines.    If no 
border is specified and grid lines have a thickness, browsers will use this as extra cell 
spacing.
Cell Padding:      Cell padding adds space around the inner margins of the cell.    If a 
border is turned on, this space is inside the border.    Cell padding is specified with as an 
index beginning with 1, with a higher index indicating a more space.    WebExpress 
defaults all tables to a cell padding of 2.



Cell Properties
You can specify the characteristics for the cells in your table here.
Vertical Alignment: This specifies how text is aligned vertically within the cell.    You can 
specify top, center or bottom for the alignment.
Cell Shade: Choose the color for the background shade in the cell.    The first entry allows
you to specify the default background, which is the same as the background for the 
document.
Width Options: You can specify the width of a table cell as a percentage of the table 
width, absolute pixels or neither.    Although you can set the width for independent cells, 
the actual width for a column will be a function of the widths for all the cells in the column.
We recommend that you attempt to use the same values for all cells in a column so that 
you have a greater expectation as to what will happen.
If you set the width as a percentage of the table width, the browser will allocate roughly 
that percentage of the table.    We say roughly, because since the total percentage of the 
cells across a table does not need to be 100%, a browser will distribute the space as best 
it can taking that into account.    If the percentages in your columns add up to 100%, you 
will have a good idea what to expect.
If you set the width in pixels, browsers will use this value as minimum width for the cell.    
If the table can be sized larger, the cell will grow in proportion to cell widths in other 
columns.    One warning when setting the cell width using pixels: although Netscape will 
allow the cell width to grow, it always formats the text into this minimum width.    This will 
very likely not produce the results you are looking for.
If you specify neither, the width of the cell is determined by a complex set of rules.    Most 
browsers behave similarly, and WebExpress does as well.    The behavior while editing may
seem somewhat unexpected, but the results are accurate.    Keep in mind, however, that 
you are not really in control of the size or dimension of the cell using this option.
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Before You Begin
Introduction
Your Web Site
Web Site Organization
Your Home Page
Images



Getting Started
Introduction
Setting Up Your Local Web
Setting Up Your Preferences
Setting Up the Path to Your Image Files
Setting Up a Permanent URL List
Setting Web Page Properties



Working with Tables Index
Introduction
The Basics
Editing Cells
Table Width Options
Cell Width Options
Borders and Shades
Nested Tables
Spanning Cells
Splitting Tables
Aligning Tables



Menu Commands
Web Page Editor Commands
Web Page Frame Editor Commands
Web Site Commands



Web Page Editor Commands
File Menu
Edit Menu
View Menu
Format Menu
Insert Menu
Table Menu
Utility Menu
Window Menu



File Menu Commands for Web Page Editor
New
Open
Close
Save
Save As
Save All
Print
Printer Setup
Exit



Edit Menu Commands for Web Page Editor
Undo/Redo
Cut
Copy
Paste
Select All
Search
Replace
Repeat Last
Goto Bookmark
Goto Current Bookmark 
Properties
Web Page Properties
Preferences



View Menu Commands For Web Page Editor
Show Table Grids
Show Paragraph Breaks
Show HTML Field Markers
Show Control Strip
Show Status Strip
Show Speed Tools



Format Menu Commands for Web Page Editor
Character
Paragraph
Bold
Italic
Underline
Revert to Style
New Paragraph
Lists



Insert Menu Commands for Web Page Editor
Hypertext Link
End Link 
Bookmark
Image
Table
Horizontal Rule
Symbol
HTML Element
Clear Left
Clear Right
Clear Both



Table Menu Commands for Web Page Editor
Insert Table
Table Properties
Cell Properties
Insert Rows
Insert Columns
Select Table
Select Rows
Select Column
Span Cells
Split Cells



Utility Menu Commands for Web Page Editor
Spell Check
Customize Speed Tools



Window Menu Commands
Cascade
Tile
Arrange Icons
Close All



Web Page Frame Editor Commands
File Menu
Edit Menu
View Menu 
Frame Menu
Window Menu



File Menu Commands for Web Page Frame Editor
New Web Site    
New Web Page 

Open 
Close 

Save 
Save As 

Save All 
Exit 



Edit Menu Commands for Web Page Frame Editor
Undo 
Frame Properties 
Frame Set Properties 
Scripts 
Preferences 



View Menu
Web Page 
Frames 
In Browser 
Show Control Strip 
Show Status Strip 
Show Speed Tools 



Frame Menu Commands for Web Page Frame Editor
Split Frame 
Combine Frames 
Insert Row 
Insert Column 
Delete Row 
Delete Column 



Web Site Manager Commands
File Menu
Edit Menu
View Menu 
Window Menu



File Menu
New Web Site 
New Web Page 
Open 
Close 
Save 
Save As 
Save All 
Exit 



Edit Menu
Open Page 
Add Page 
Remove Page 
Update Web Pages 
Web Site Properties 
Preferences 



View Menu
Expand Link 
Expand All Links 
Collapse All Links 
Bookmarks 
Global Links 
Images 
Page Titles 



Keyboard Shortcuts

File Shortcuts
The following shortcuts are used when working with files:

Ctrl-N Create a new file
Ctrl-O Open an existing file
Ctrl-S Save the current file
Ctrl-W Close the current file
Ctrl-P Print the File
Ctrl-Q Exit WebExpress

Windows Shortcuts
The following shortcuts help manage the windows within WebExpress:

F1 Bring up the Windows Help facility.    
Ctrl-F4 Closes the current document window.
Alt-F4 Exits WebExpress.
Ctrl-F5 Restores the current document window to normal size.
Alt-F5 Restores the main WebExpress window to normal size.
Ctrl-F6 Cycles to the next open document window.
Sh-Ctrl-F6 Cycles to the previous open document window.
Ctrl-F9 Minimizes the current document window.
Alt-F9 Maximizes the current document window.
Ctrl-F10 Minimizes the main WebExpress window.
Alt-F10 Maximizes the main WebExpress window.

Clipboard Shortcuts
The following shortcuts move selections between documents and the clipboard.

Ctrl-X Cut the selected text or object to the clipboard.
Shift-Del Cut the selected text or object to the clipboard.
Ctrl-C Copy the selected text or object to the clipboard.
Ctrl-Ins Copy the selected text or object to the clipboard.
Ctrl-V Paste the contents of the clipboard to the document.
Sh-Ins Paste the contents of the clipboard to the document.

Cursor Movement Shortcuts
The following shortcuts are used when selecting text:

LArrow Move to the previous character
RArrow Move to the next character
Ctrl-LArrow Move to the previous word
Ctrl-RArrow Move to the next word
UArrow Move to the previous line



DArrow Move to the next line

Ctrl-9 Move to the previous sentence
Ctrl-0 Move to the next sentence
Ctrl-UArrow Move to the previous paragraph
Ctrl-DArrow Move to the next Paragraph

Home Move to the beginning of line
End Move to the end of line
Ctrl-Home Move to the beginning of document
Ctrl-End Move to the end of document

PgUp Move to the previous window
PgDn Move to the next window
Ctrl-PgUp Move to the beginning of current window
Ctrl-PgDn Move to the end of current window

Tab Move to next cell (tables only)
Shift-Tab Move to previous cell (tables only)

Text selection Shortcuts
The following shortcuts are used when selecting text:

Sh-LArrow Select the previous character
Sh-RArrow Select the next character
Sh-Ctrl-LArrow Select the previous word
Sh-Ctrl-RArrow Select the next word
Sh-UArrow Select the previous line
Sh-DArrow Select the next line

Sh-Ctrl-9 Select the previous sentence
Sh-Ctrl-0 Select the next sentence
Sh-Ctrl-UArrow Select the previous paragraph
Sh-Ctrl-DArrow Select the next Paragraph

Sh-Home Select to the beginning of line
Sh-End Select to the end of line
Sh-Ctrl-Home Select to the beginning of document
Sh-Ctrl-End Select to the end of document

Sh-PgUp Select up one window
Sh-PgDn Select down one window
Sh-Ctrl-PgUp Select to the top of current window
Sh-Ctrl-PgDn Select to the bottom of current window

Ctrl-A Select entire document or table cell

Text editing Shortcuts
The following shortcuts perform standard text editing commands:



Ctrl-Z Undo/Redo the last command or action.
Alt-BkSp Undo/Redo the last command or action.

BkSp Delete the previous character or selection.
Del Delete the next character or selection.

Sh-Enter Inserts a line break within the current paragraph (no paragraph break)
Enter Inserts a paragraph break.

Character Formatting Shortcuts
The following shortcuts perform text formatting commands:

Ctrl-B Apply bold to the selected text 
Sh-Ctrl-B Apply bold to the selected text 
Ctrl-I Apply Italics to the selected text 
Sh-Ctrl-I Apply Italics to the selected text 
Ctrl-U Apply underline to the selected text 
Sh-Ctrl-U Apply underline to the selected text 

Ctrl-T Access the character dialog box
Ctrl-F Access the Font drop down on the control strip
Ctrl-P Access the Font Size drop down on the control strip

Paragraph Formatting Shortcuts
The following shortcuts perform text formatting commands:

Sh-Ctrl-L Left align the selected paragraphs
Sh-Ctrl-R Right align the selected paragraphs
Sh-Ctrl-C Center align the selected paragraphs
Sh-Ctrl-J Justify the selected paragraphs

Ctrl-7 Decrease paragraph indent
Ctrl-8 Increase paragraph indent

Ctrl-M Access the paragraph dialog box.
Sh-Ctrl-S Access the paragraph style drop down on the control strip.

Command Shortcuts
The following shortcuts menu command shortcuts:

Ctrl-F Search for patterns in text
Ctrl-H Search and replace patterns in text
F3 Repeat last search or replace

Sh-Ctrl-N Insert Symbol

F5 Goto Bookmark



Sh-F5 Insert Bookmark
F9 Goto Current Bookmark (within Hypertext link only)

F7 Spell Check



Meta Commands
Meta commands add directives to browsers and search engines to perform certain 
operations in conjunction with your web page, or to obtain certain information from your 
web page.    There are two types of directives, User Variables and System Variables.    The 
User Variables generally supply information, the System Variables generally tell the 
browser specifics regarding how it should deal with your page.
Meta commands are constructed from two elements, a name and a value.    The name 
identifies the type of meta command, the value provides your information.

The Meta Command Dialog
There are two tabs to the Meta Command dialog box, User Variables and System 
Variables.    Both perform the same function, but are organized separately.    The following 
describes the fields you will find on either tab.
Meta Commands Lists: Shows the list of currently defined meta commands.    The name 
precedes an equal sign (=), followed by the value enclosed in quotes.
Name: Enter the name portion of the meta command.    Do not include equal signs or 
quotes in this field.
Value: Enter the value portion of the meta command.    Do not include equal signs or 
quotes in this field.
Add:    Adds the current information from the Name and Value fields to the list of meta 
commands.    You should be sure that both parts have been entered correctly before 
adding.
Delete: Removes the currently selected meta command from the list.    



Before You Begin
Using WebExpress, you will be amazed at how fast you can create a great looking web 
site.    Whether you’re an experienced WebMaster looking to enhance and maintain a 
current site, or you’re new to web page design, ready to create your first page, the visual 
design offered by WebExpress will greatly enhance your productivity.
By visual design, we mean you’ll use tools to build up your web site just as it will look 
when loaded into a browser.    You will not be sidetracked by the clutter and confusion of 
HTML codes.    Instead you can focus on your message and its presentation.    
Before you begin, it is helpful to think about and understand some big picture issues, 
which will help you organize and maintain your web site better.    The following are some 
guidelines that we’ve found work well for many of our users.
Next



Your Web Site
A web site is typically a collection of HTML documents (web pages), images, and files 
available for download by those visiting your site.    More sophisticated sites may also have
cgi or java scripts, and other automated information retrieval devices.    In its simplest 
form, however, it is a collection of files on a computer.
This collection of files is located on a computer somewhere, either at the location of your 
home or business, or at the location of your Internet service provider.    Your files are 
stored in a folder or subdirectory structure somewhere on that computer.    Your site is 
identified by an ID used by the Internet to locate the computer on the network, and the 
location of your directory structure on the computer.

Your Local Web
Regardless of where this computer is located on the Internet, or where your files are 
located on that computer, it is easy useful to maintain a mirror image of your web site on 
a local computer. This will allow you to safely edit your pages without disrupting your web 
site, effectively simulates the environment once it is uploaded to the Internet, and 
provides you with a backup copy of all the files on your site.
Another benefit of having a local web is that when you are ready to activate your web site,
you can upload the entire site at once.    This will eliminate searching for the various files, 
or worse, potentially missing some important files which need to be updated or added to 
your web.
Next Previous



Web Site Organization
In its simplest form, your web site is a single folder which contains all the files which make
up your web.    This would include HTML documents (web pages), images, files which can 
be downloaded, and anything else you find necessary.
This works well for smaller sites.    Everything is conveniently located in one place, and 
referencing the different pages and elements is easy when creating hypertext links to 
them.    For larger sites, this may become unwieldy, however, and more organization is 
needed.
One common organization of a web site is to create several sub-folders off of your main 
folder.    One can be used for web pages, one for images and one for files which can be 
downloaded.    This conveniently separates the different types of components, and stores 
them together.    You may also want to further break down the structure by subject matter.
In any event, if you anticipate your site growing from a smaller one to a larger one, you 
may want to think about its organization.    While WebExpress makes it easy to change 
hypertext links to the different elements, it will still require some work and attention to 
detail when and if the structure changes.
Next Previous



Your Home Page
You need to have a entry point into your web site. Typically you will design one page to be 
the entry point, which welcomes visitors and allows access to all other areas of your web 
site.    This is commonly referred to as your home page.    The address (or URL) to your 
home page is what someone will type into their browsers to direct it to your site.    
Businesses typically have domain names which they associate with their web sites.    The 
name for a domain usually has a connection with the business itself.    It is desirable to 
allow users to simply type in a domain name, to make is easy to remember.
To accommodate using the domain name, most web server software packages have 
standardized on several names to use for your home page.    The server will automatically 
look for an HTML document of one of these names when a user connects via a domain 
name.    They will look for one of the following names in this order:

INDEX.HTML
WELCOME.HTML
HOME.HTML
INDEX.HTM
WELCOME.HTM
HOME.HTM

Note that it first looks for the HTML extension for files.    This is due to the Internet’s UNIX 
heritage.    The HTM extension is becoming more and more common with the influx of PC 
based systems, and works fine, so long as you don’t mix them (the HTML extension takes 
precedence when two files otherwise have the same name).
If your web site piggy backs on another, and you need to explicitly include an HTML 
document in your address (URL), you should try to make it easy for a user to remember, 
and make it fit with the purpose of the page.
Next Previous



Images
Images play a large role in designing an attractive and interesting web site.    You can 
display your company’s logo, show snapshots of products, and draw a reader’s attention to
points of interest.    As the Web matures, the proper use of images will play an increasingly
important role.
Due to modem speeds and Internet traffic, however, there is a downside to over using 
images.    Large, very colorful images tend to take considerable time to download, even 
when using a 28.8K modem.    Some users may become impatient waiting for the graphics 
to download.    You will need to balance the importance of your image to your message 
with the time it takes for a user to download that image to your computer.
WebExpress supports the two most common image formats found on the Internet: GIF and
JPEG.    They have become popular due to their ability to compress high quality color 
images into the smallest possible size, saving transmission time in the process.    While 
many other fine image formats exist, stick to these two formats and you will be sure that 
all graphical browsers will support you.
GIF is designed for images of 256 colors or less, and works very well for images with solid 
colors such as clip art and logos.    JPEG is designed for 24 bit color images and is often 
used for photographic images.    GIF also has the advantage of designating one color to be 
transparent, so that it can be seamlessly displayed on a patterned background.    
If you have images in other formats, you will need to convert them to GIF or JPEG before 
using them in your web pages.    We can suggest two fine software programs which will 
allow you to accomplish this.    One is Adobe Photoshop, the other is PaintShopPro from 
JASC, Inc.    Both programs will allow you to convert your images, as well as touch up 
images, reduce the number of colors, and set transparent values.
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Getting Started
After you’ve thought about the big picture a little bit, it’s time to get started creating Web 
Pages.    WebExpress is extremely easy to use; if you’ve used a Windows word processor 
you’re well on your way.    Here are a few tips to help move things along.
Next



Setup Your Local Web Site
The first thing to do is to designate a folder on your computer which will be the base for 
your local web site.    This will be where you should store your web pages and images, and 
should mirror your web site on the Internet.    If you are using WebExpress to maintain an 
existing site, if you haven’t already setup up a local web you may want to consider to 
doing so now.    See the Before You Begin section for more on web site organization.
Next Previous



Setup Your Preferences
It is a good idea to find out what is available as preferences in WebExpress from the start, 
so that as you begin working with it, you know what you can customize to your tastes.    
Some preferences dictate how WebExpress works and what tools are available, while 
others dictate the default behavior for web pages or elements on them.    For more about 
the specific options available, see    Preference Dialog Options.    
Next Previous



Setup Your Image Path
One preference of special note is the one which tells WebExpress where to look for 
images.    This is important, because in an HTML document, you don’t specify where the 
image is located on your computer, it specifies where to look on the Internet.    
WebExpress will use the same filename used on the Internet, and search the Image Path 
when it needs to display the image.
This path can be relative to your local web site, or an explicit location on your hard disk.    
For example, if you always store images on your web sites in a folder named IMAGES, and 
that folder is located just below the base folder for your web, you can simply enter 
IMAGES.    This will then work for all web sites with the same configuration.
Alternatively, you may like to store all your images in one place on your hard disk for easy
reference by all programs.    In this case, you will want to include the full path to that 
location. For more about the specific options available, see    Preference Dialog Options.
Next Previous



Setup Permanent URL List
You will find that some URL addresses are used in a lot of different places. For 
convenience, WebExpress makes it easy to reference these common URLs without having 
to re-enter them each time.
We can give several examples of these common addresses.    For example, you will 
probably always want to include a link back to your home page on all your supporting web
pages.    Another example is if you have a navigational toolbar of significant locations 
within your web, and the toolbar is used on all your pages.    Finally, you can add all your 
e-mail addresses to the list, so that you can receive feedback from those visiting your web
site.
Use the Link command from the Insert menu to bring up the URL dialog.    You can then 
add all your most common addresses to the permanent list.    This guarantees that these 
important addresses will be available each time you create new hypertext links.
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Setup the Web Page Properties
Each web page contains the default characteristics for how that page will behave and 
look.    You can setup background colors or images, the default color for text and    
hypertext links.    You can even setup sounds to use each time someone visits your page.
You can also enter META commands and information.    If you submit your page to search 
engines, you will want to find out what META command are used by the search engine, 
and specify them here.    It is a powerful way for potential visitors to find your site.
Each time you create a new web page, you will be given the opportunity to setup the 
properties for the page.    You can, of course, edit them at any time using the Web Page 
Properties command from the Edit menu.
Previous



Copyrights and Patents
WebExpressTM for Windows
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Working with Tables
Tables are the most powerful tool defined in HTML for precisely laying out the presentation
of your web page.    They allow you to give the allusion that text and images can be 
positioned independently anywhere on the page.    This is achieved by understanding and 
taking advantage of this powerful tool.    WebExpress is particularly powerful in 
manipulating tables.
Due to the demand that browsers must adapt web pages to different window sizes and 
screen resolutions, tables must be able to size dynamically.    This contrast starkly from 
tables in a word processor or desktop publisher where the size of the final page is defined 
and controlled.    HTML uses a complex set of rules to determine this behavior, which is 
understood by few (explaining all the different behavior in browsers).    We will try to shed 
some light on this so that you can keep this in mind while designing your pages.
These rules also make editing tables something of a challenge.    In order to match how a 
page will look in a browser, it is necessary to continuously resize and position cells and 
tables.    If you find the behavior a bit squirrelly at first, stick with it.    Soon you will know 
what to expect and understand what is happening.
In any event, if you don’t already use tables in your web pages, we seriously recommend 
that you spend some time experimenting with them, and learning to use them.    The time 
spent now will greatly pay for itself with the enhanced look and feel of your web pages 
later.
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The Basics
Tables, in their simplest form, are a matrix of cells laid out in rows and columns.    Each cell
can contain text, images, or even another table.    In fact, you can think of a table cell as a 
sort of miniature web page of its own.
In order to allow tables to more precisely control the layout of the various elements on a 
page, groups of cells can be combined.    This gives tables the ability to avoid a simple 
matrix appearance.    The combining of cells is called spanning.
Tables can also be nested within the cell of another table.    This further provides the ability
to give a non-uniform look to the table.    By using a combination of nested tables and 
spanned cells, it is possible to very cleverly layout the elements of a page in almost any 
way imaginable.
Any table can have borders around it.    You can specify the thickness of the border, as well
as the thickness of the grid within the table.    You can also specify that extra padding be 
placed in each cell to produce the effect of cell margins.    Individual cells, or a collection of
cells, can have background shades.    
At this time, the current versions of the most popular browsers all support tables, and 
most of the attributes for the tables described above.    In the future, all browsers will have
to support them.    You may want to keep in mind, however, that there are still browsers 
currently in use that do not support tables.    When those browsers encounter pages with 
tables, they are displayed with varying degrees of success (or failure).
Next Previous



Editing Cells
Table cells can be edited just like any other text in your document.    You can format the 
text, insert images, horizontal rules, and even tables.    Just click into the cell you wish to 
edit and begin typing.
To move from one cell to the next using the keyboard, press the Tab key.    To move to the 
previous cell, press Shift-Tab.    You can also use the arrow keys to move up and down, and 
left and right.    The left and right arrow keys will take you to the next or previous cell, 
respectively, when they are at the beginning or end of the text in the cell.
If you are in the first cell of the table, you can use the left or up arrow keys to cursor out of
the table.    If the table is at the beginning of the document, the cursor will be blinking just 
to the left of the edge of the first cell.    You cannot type in this location, but you can press 
Enter to insert a new paragraph above the table in which you can type.
If you are in the last cell of the table, you can use the right or down arrow keys to cursor 
out of the table.    If the table is at the end of the document, the cursor will be blinking just
to the right of the edge of the last cell.    You cannot type in this location, but you can press
Enter to insert a new paragraph below the table in which you can type.
You can select multiple contiguous cells to apply formatting to all of them in one 
operation.    Begin by selecting text in the first cell you wish to select, and continue 
moving the mouse out of the cell into the next cell you wish to select.    Continue until all 
cells have been selected.    You can then apply character formatting, paragraph formatting,
and cell properties to them as a group.    Once you are in cell select mode, you can not 
return to text select mode until you deselect the cells.
You can select rows, columns, or the entire table by using the corresponding commands 
on the Table menu.
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Table Width Options
The width of a table can be controlled in three basic ways.    It can be specified as a 
percentage of the width of the window in which the page is displayed (or the cell in which 
it is contained if it is a nested table).    It can also be specified as having a fixed width in 
pixels, which allows you to precisely control the table’s width.    The final option is to not 
specify either, and let the table grow and shrink as a function of the data within it.
While giving a table a precise width in pixels may seem like a good idea while designing 
your page, keep in mind that people will view your page in much different configurations 
than the one you are using, very possibly ones you haven’t even considered.    Therefore, 
using a precise width will abort the browsers ability to dynamically size the table 
according to the viewers window size.    It is a very useful command in the right 
circumstances, but it should be used with care.
If you have not specified a method for the browser to use in determining the tables width, 
it will use a complex set of rules for determining the width based on the widths of the 
individual cells.    This gives a very dynamic sizing table, but offers the least amount of 
control.    Keep in mind that if this option is set, the table will size as you type, adjusting its
size to the data, just as it will look in a browser.
The default options for a table size in WebExpress is 100% of the width of the viewer’s 
screen.    If you usually create tables with a different width setting, you can change this in 
the Preferences Dialog.
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Cell Width Options
Just as entire tables have settings for the width, so do individual cells.    The settings for 
the cell widths affect the width of an individual cell, the width of the column containing 
the cell, and potentially the entire table.
Cell widths can be specified as a percentage of the width of the entire table, as a 
minimum width in pixels, or neither.    If neither is specified, the width of the cell is 
determined by the data within the cell.    The widest cell in a column determines the width 
of the entire column.
Many browsers will also never let a cell become smaller than the width of its widest data.   
This means that it will never become smaller than the width of an image inserted in the 
cell, or the longest string of text which does not contain a space (spaces allow the text to 
wrap to the next line).    WebExpress currently honors minimum width settings, and will 
clip images and wrap text with no spaces.    This can lead to some differences in the way 
tables are displayed in WebExpress and a browser.
Each cell width can be specified independently, which can therefore lead to confusing 
results.      For instance, in a four column table, all cells can be specified to use 50% width 
of the entire table.    This, of course, is impossible.    What will really happen in this case is 
that it will be split evenly, or each cell will occupy 25% of the table’s width.    We bring this 
up to encourage you to be consistent in the way you specify width options, so that the 
behavior is more predictable.
In tables which have neither a table width option set nor cell width options set, the table 
will grow dynamically as you type.    It will begin very small, and will grow and resize as 
you type.    It may seem peculiar as you are typing, but it is an accurate representation of 
how the table will appear at any given point in time.    Once you have all your data 
entered, the resizing will begin to settle down and become more stable.
The default options for cell widths in WebExpress is to give each column an even 
percentage of the table’s width when it is created.    For example, if you create a new table
with four columns, each cell will have its width set to 25%.    If you usually create tables 
with a different setting for cell width, you can change this in the Preferences Dialog.
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Borders and Shades
Tables can have borders specified.    Individual cells can have a background shade 
specified.    To set the border and background shade for the entire table, first use Select 
Table from the Table menu.
Borders are set in the Table Properties dialog.    Borders are specified as a relative 
thickness.    The thickness is specified as a number starting from zero.    Zero means no 
border.    The larger the number the thicker the border.    Keep in mind that this is not an 
absolute thickness in pixels, but an index used by the browser to determine thickness.    
Each browser may look slightly different.
The grid between cells is specified in the same way.    A table has to have a border, 
however, in order to have a grid thickness.    A zero setting for the grid in a table with a 
border specifies the thinnest grid.    In tables without a border, an entry for the grid will be 
used as extra cell padding.
Cells can have background shades, set in the Cell Properties dialog.    Background shades 
can be used to highlight cells of particular interest, or an entire row, column or table.    If a 
cell has a background shade set, it takes precedence over the background color or image 
for the page.    If no background shade is set, it uses the properties for the page.
Note: You should be aware that not all browsers will display background shades in cells.    
Netscape, before v3.0, is one such prominent browser.    When deciding to whether or not 
to use cell shades, you should decide if such compatibility is needed.
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Nested Tables
You can insert tables into cells, essentially nesting a table within another.    This allows 
great flexibility when aligning various elements within a table cell.    In principle, there is 
no limit to the number of levels of nesting, but in practice, you will run up against the 
physical restraints of window size and screen resolution.
Keep in mind when nesting tables that each table is independent from the others.    You 
cannot select some cells in one table, and some in another and apply cell properties to 
them.    You must edit and format each table independently.
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Spanning Cells
Spanning cells is a method of combining cells into one supercell that occupies the space 
of all the spanned cells.    This is often used to create a table heading along the top of a 
table, or along any of its other edges.    It also allows you a way to allow text to appear to 
flow around both sides of an image, or create captions and textual descriptions of the 
image.
Spanned cells are also a great way to align elements on a page in a non-uniform way.    By 
spanning cells, you can completely remove the matrix appearance of a table, and create a
variety of rectangles of different sizes and shapes positioned independently on the page.
Next Previous



Splitting Tables
You can split tables across row boundaries.    To do so, position the mouse cursor to the 
right of the table at the position you wish to split the table.    Click with the mouse using 
the left button.    The cursor will blink at the edge of the table, but it is positioned just 
outside the cell.    You will not be able to type in this location, but you can press Enter to 
split at the table.
You can combine two tables with the same number of columns, which are separated only 
by blank paragraphs.    To do so, click to the right of the last row in the first of the two 
table which you wish to combine.    Then, simply press the delete key, and the two tables 
will be joined.
It’s a little tricky to get a feel for clicking outside a table like this, but once you’ve done it 
once or twice, you will become accustomed to the behavior.
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Aligning Tables
Tables which do not extend the entire width of the window can be aligned to the left, 
center, or right of the window (or enclosing table cell), just as normal text can be aligned.  
To do this, you must actually set the alignment in the paragraph into which the table is 
inserted.
Position the mouse cursor to the right of the table you wish to align, and click with the 
mouse using the left button.    The cursor will blink at the edge of the table, but it is 
positioned just outside the cell in the paragraph itself.    You will not be able to type in this 
location, but you can click the Alignment buttons on the Control Strip, or choose 
Format/Paragraph to set the alignment.
Although it’s a little tricky to click outside a table like this, it is necessary to distinguish 
between the table itself, and the contents of one of its cells.    Once you’ve done it once or 
twice, you will become accustomed to the behavior.
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Using the WebExpress Logo
If you’ve found that using WebExpress has helped design and create your web pages, and 
you’d like to help us spread the word, we’ve created two special logos which you can 
attach to your web page for this purpose.    

As depicted here, they are small, attractive icons, which simply state your page was 
designed using WebExpress.    Pick the one which looks best on your page.    Generally, 
they are placed at the bottom where it will not interfere with your message.    Even better, 
link it to our home page at www.mvd.com so that others interested in WebExpress can 
get more info. 

The logos are installed into your DOCS folder under the folder you specified when you ran 
the setup program.    They are named WXLOGO1.GIF and WXLOGO2.GIF.    If you do use 
them, thank you very much!

Whether you use the logo or not, drop us a note letting us know the address to your web 
site, so we can see all the great pages created with WebExpress!

 




